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Introduction 

This document provides guidance for performing field surveys using a total 
station unit (TSU) and connected handheld data collector and for downloading 
collected point data. 

WPES uses a Sokkia CX-series TSU and a data collector running Carlson 
SurvCE software.  Minor differences in instrument set-up may arise if using a 
different TSU.  Major differences in data collection procedures will occur if 
using a different data collection software.  
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Before leaving for field 

1. Equipment list 
1.1. Total Station equipment: 

1.1.1. CX-105 Total Station Unit (TSU) 
1.1.2. TSU batteries, charged 
1.1.3. Carlson handheld Bluetooth data collector, charged 
1.1.4. Tripod 

1.2. Prism equipment: 
1.2.1. Prism(s) must be matching pair with pole 
1.2.2. Prism pole(s) 
1.2.3. Bipod(s) 

1.3. Additional equipment 
1.3.1. Field notebook 
1.3.2. Flags/Pins for marking station locations 

1.3.3. Orange nail polish for discreetly marking station locations on hard 
surfaces 

1.3.4. Magnetic compass 
1.3.5. Metric open-reel measuring tape 
1.3.6. GPS unit, charged 
1.3.7. Walkie talkies, charged 
1.3.8. Waders, life jackets location-dependent 

2. Magnetic declination 
2.1. Record magnetic declination for survey area at 

ngdc.noaa.gov/geomag/calculators/magcalc.shtml 
Note:  Magnetic declinations for Maine coast range from -14.75°  to -16.5°  
(west declinations are negative). 

  

https://ngdc.noaa.gov/geomag/calculators/magcalc.shtml
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Field operation 

1. Instrument set-up 
1.1. Turn on GPS unit and place it at point where total station will be set 

up while unpacking other gear. 
Note:  GPS unit should be allowed to sit for several minutes after acquiring 
satellites to improve accuracy of reading.  This step is unnecessary if XYZ 
coordinates of point are known (e.g. you are occupying a survey control point). 

1.2. Set up tripod over initial point, with head (top plate) as level as 
possible and opening directly above point; make sure tripod feet are 
securely anchored in soil and slip joint clamps are locked. 
Note:  Sight down through the hollow mounting screw to help center over point. 

1.3. Place total station unit on tripod head and secure using mounting 
screw. 
Note:  Use both hands when carrying TSU – do not carry solely by handle. 
Tighten to finger tight – do not over-tighten. 

1.4. Perform gross leveling of instrument using bullseye level bubble on 
tribrach by making small adjustments to one tripod leg at a time; 
make sure to securely re-lock slip joint clamp before moving on to 
next leg. 

1.5. Turn on total station unit. 
1.6. If level bubbles do not appear on TSU screen, press “Shift” key on 

unit face until “TILT” appears over F2 key (and press that). 
1.7. Perform fine leveling of instrument using on-screen level bubbles by 

adjusting leveling foot screws on tribrach. 
Note:  The easiest way to do this is to align face of instrument with one of the 
three sides of the tribrach, then use *one* of the two foot screws along that side to 
level instrument in the Y direction and the third foot screw (at opposite vertex) to 
level instrument in the X direction. 

1.8. Turn on laser plummet by pressing ‘L-ON’ (F2). 
If re-occupying an established point (mark on the ground), 
continue to step 1.9; otherwise place a flag/pin at laser dot and 
skip to step 1.11. 
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1.9. Loosen mounting screw and gently slide instrument until laser is 
directly on point; re-tighten mounting screw.  
Note:  Do not rotate tribrach while sliding instrument or it will go out of level. 

1.10. Check level using on-screen level bubbles and repeat steps 1.7 and 1.9 
as necessary until instrument is level and directly over point. 

1.11. Turn off laser plummet and press ‘OK’ (F1). 

2. Data collector set-up 
2.1. Turn on data collector and open SurvCE program (Start menu). 
2.2. Choose “Select New/Existing Job” from on-screen prompt. 
2.3. Choose “Connect to last BT device” from on-screen prompt to 

connect data collector to total station unit. 
Note:  This prompt may appear at a different stage in the set-up process, and 
will reappear if collector goes to sleep. 

2.4. If creating a new survey job: 
2.4.1. Enter descriptive name in “Name” field at bottom of screen; 

tap green check mark (upper right). 
2.4.2. “Job Settings” screen will open; if necessary, make changes to 

reflect job requirements (rare), then tap green check mark. 
Note:  By default, “Distance” = ‘Metric’, “Angle” = ‘ Degrees, 
Minutes, Seconds’, “Zero Azimuth Setting” = ‘North’, “Projection” = 
‘UTM/WGS 84/UTM zone 19N 66-72W’. 

2.4.3. “Enter Point Coordinates” screen will open; enter Easting, 
Northing, and ground elevation of TSU set-up point and tap 
green check mark. 
Note:  Ensure that GPS coordinates are in the same projection 
as set in the previous step, and that Easting and Northing are 
entered in the correct order.  If using UTM (preferred), Maine is 
in UTM zone 19.  For the Maine coast, Easting is a 6-digit number 
in the range (350 000 : 650 000) and Northing is a 7-digit number 
in the range (4 770 000 : 5 000 000); Bryand GSC is at [19T 526260 
4971320 (NAD83)]. 

2.4.4. If you will occupy or backsight to additional known 
control points during job: 
2.4.4.1. Tap “File” tab at upper left of screen. 
2.4.4.2. Tap “3 Points”. 
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2.4.4.3. Tap “Add”. 
2.4.4.4. Enter Easting, Northing, Elevation, Description; 

tap green check mark. 
2.4.4.5. When all points have been added, tap red “back” 

arrow. 
2.4.5. Tap “Survey” tab at upper left of screen. 
2.4.6. Tap “1 Store Points”. 
2.4.7. “Store Points” screen will open. 

2.4.7.1. Occupy Point:  1 
2.4.7.2. Continue to step 2.5. 

If continuing an existing survey job: 
2.4.8. Select existing job file; tap green check mark (upper right). 
2.4.9. Tap “Survey” tab at upper left of screen. 
2.4.10. Tap “1 Store Points”. 
2.4.11. “Store Points” screen will open. 

Note:  “Single Setup” tab should be highlighted – tap it if not. 
If establishing a new point for TSU location:  set 
“Occupy Point” to an unused point number and continue to 
step 2.5. 
If re-occupying a stored point with the TSU:  set 
“Occupy Point” to number of stored point  and continue to 
step 2.5. 

2.5. “Store Points – Remote Benchmark Single Setup” screen 
2.5.1. Instr. Height:  use tape to find height from ground to notch 

at scope on side of TSU 
2.5.2. Target Height:  enter prism height 

Note:  For unbranded prism/pole combo, ensure pole adapter is 
correctly calibrated (see Appendix B). 

2.5.3. Backsight Point, Backsight N Azi:  continue to step 3. 

3. Backsighting 
3.1. Send assistant with prism/pole to backsight location. 

Hold the pole still and level, please, kind assistant. 



5 

 

3.2. If sighting from a new or re-occupied TSU location to a new 
backsight point: 
3.2.1. Set “Backsight Point” to an unused point number. 

Note:  For a new survey job, use “2”. 
3.2.2. Continue to step 3.3. 

If sighting from a new TSU location to a stored backsight point: 
3.2.3. Set “Backsight Point” to that point number. 
3.2.4. Continue to step 3.3. 

If backsighting from a re-occupied TSU location to a stored backsight 
point: 
3.2.5. “Backsight N Azi” field will be locked. 
3.2.6. Tap “Backsight” box (lower right) and skip to step 3.4. 

3.3. Use magnetic compass to sight azimuth from TSU to backsight. 
Note:  Azimuth is angle measured clockwise from N (e.g. due west is 270° ). 
3.3.1. If using a compass with adjustable declination, adjust to 

survey area’s magnetic declination then take azimuth reading 
to backsight; this is a true azimuth (polar N = 0° ). 
If using a compass without adjustable declination (most 
hand compasses), the azimuth reading is in relation to 
magnetic north rather than true north; to convert compass’s 
reading to a true azimuth, add the survey area’s magnetic 
declination to the magnetic azimuth.  
(e.g. 86.5°(mag. az.) + [-15.3°](declination) = 71.2°(true az.)). 

3.3.2. Enter true azimuth in “Backsight N Azi” field in data 
collector. 

3.3.3. Tap “Backsight” box (lower right). 
3.3.4. Tap “Continue” on “Backsight Method” screen. 

3.4. Begin backsight with vertical clamp / fine adjustment screw on total 
station unit face pointing toward yourself (away from the backsight 
location) and scope pointing toward backsight; vertical and horizontal 
clamps should be unlocked. 

3.5. Sight through scope to prism, focusing scope as necessary. 
Note:  You should be able to see ＋shaped reticles embedded in scope and radial 
reticles embedded in prism. 
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3.6. When prism is in scope crosshairs, lock vertical and horizontal clamps. 
3.7. Use vertical and horizontal fine adjustment screws to center scope’s 

crosshairs on center of prism. 
3.8. Tap “Set Angle and Read” box on screen, and after a successful 

reading a message will pop up on screen directing you to reverse the 
instrument face. 

3.9. Unlock vertical and horizontal clamps, rotate instrument 180° and 
plunge scope (flip it 180°), and repeat steps 3.5 – 3.7 to sight in on 
prism. 

3.10. Tap ‘OK’ and the total station unit will take a second reading. 
3.10.1. If a message pops up on screen warning that the difference in 

angles is outside tolerance, tap ‘No’ and return to step 3.4. 
3.11. When “Set Report” page appears on screen, tap green check mark . 
3.12. When “Backsight” page appears on screen, tap green check mark. 
3.13. When “Store Point” popup appears on screen, change description to 

‘BS’ and tap green check mark. 
3.14. After completing backsight process, the view will automatically 

change to the “Store Points” screen, which shows a map view of the 
survey job.  This screen can also be accessed by tapping the “Survey” 
tab and tapping “1 Store Points”. 
Note:  For each visible point, the black number above the point is the point 
number, the blue number to the right of the point is the point’s elevation, and 
the green text below the point is the point’s description. 

3.15. Before making any other readings after backsighting, return 
instrument to original orientation (scope facing backsight, 
clamp/screw toward yourself), then turn to next target (step 4 or 
step 5). 

4. Side shots 
Note:  “Side shots” are points measured without relocating the TSU.  For a typical site 
survey where the TSU is set up with a commanding view of the area, most or all 
measurements will be side shots. 

4.1. Send assistant with prism/pole to point. 
Good work, assistant.  We appreciate you.  Keep the pole level, please. 

4.2. Place flag/pin at point. 
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4.3. Sight in total station unit on prism (see steps 3.5 – 3.7). 
4.4. Tap the large ‘R’ at top left of screen to read angle and distance.   

4.4.1. A marker with a ‘?’ above it will appear on the map.  If it 
appears 180° from where it should be, ensure you 
followed step 3.15 after backsighting.  Readings can be 
taken as many times as you wish without storing the point. 

4.5. If you are satisfied with the reading, give the point a description and 
tap the large ‘S’ at top left of screen to store the point.  
4.5.1. Common point descriptions include: 

TW – thalweg (deepest point of stream channel cross-
section) 

REW, LEW – right and left edges of water 
BB, BoB – bottom of bank 
TB, ToB – top of bank 
XS1 – prefix for cross-section 1 
RPIN, LPIN – pin or flag at end of cross section on 

river right or river left 
INST – generic label for location of an instrument (level 

logger, etc) 

5. Traversing 
5.1. To traverse to a point, sight in on the prism as in steps 4.1 – 4.3, then 

tap the large T at top of screen. 
Note:  The TSU will read and store the location of the prism/pole. 

5.2. When “Move to Traverse” screen appears, tap “Move Now”. 
5.3. “Store Points – Remote Benchmark Single Setup” screen will appear. 

5.3.1. Occupy Point: the number of the point you are traversing to. 
Backsight Point: the number of the point you are traversing 
from. 
Both fields should be correctly autofilled. 

5.3.2. Tap ‘Backsight’. 



8 

 

5.4. Break down TSU and tripod (steps 6.3 – 6.4) and set up over point 
you are traversing to (steps 1.2 – 1.11). 
Note:  NEVER pick up and move tripod while TSU is still attached, even for 
short distances.  This will damage the instrument.   

Before moving either TSU or prism pole, be sure each location is flagged/pinned.  
You must precisely re-occupy these locations. 

5.5. Send assistant with prism/pole to occupy the point you are traversing 
from. 

5.6. Backsight to point you are traversing from (steps 3.4 – 3.12, 3.14 – 
3.15). 
Note:  Once complete, you can take additional side shots (step 4) and/or traverse 
to another point (step 5). 

6. Finishing a job 
6.1. Once all points have been measured, tap red ‘X’ at top right of data 

collector screen to leave “Store Points” map page, tap “File” tab, then 
tap “0 Exit”.  The data collector can now be powered down. 

6.2. Power down total station unit. 
6.3. Unlock vertical and horizontal clamps – the instrument should be 

able to turn freely on both axes. 
6.4. Unscrew mounting screw and remove TSU from tripod. 

Note:  Use both hands when carrying TSU – do not carry solely by handle.  
6.5. Replace scope cover and return TSU to case. 
6.6. Break down and store prism/pole, tripod, and other gear.  
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Post-survey tasks 

1. Equipment storage 
1.1. Return all equipment to equipment room. 

1.1.1. Return data collector, TSU battery, GPS unit, and walkie 
talkies to charging stations. 

1.1.2. Hang wet waders and/or life jackets to dry. 
1.2. If surveying was completed in damp or humid conditions, allow TSU 

to sit open to indoor air before storing in closed case. 
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Survey data download 

1. Equipment list 
1.1. Carlson handheld data collector 
1.2. USB Mini-A or USB Mini-B to USB A data transfer cable 
1.3. Computer(s) with: 

1.3.1. Windows Mobile Device Center   
This service was broken on Windows 10 operating systems, but 
workarounds to get it running properly exist – see e.g. 
www.accuratedata.com/wordpress/index.php/2017/08/02/. 

1.3.2. Carlson X-Port software 
Available as a free download at 
www.carlsonsw.com/support/software-downloads/. 

2. Accessing raw data 
2.1. Turn on Carlson data collector and connect it to computer using data 

transfer cable. 
2.2. Open Windows Mobile Device Center and click “Connect without 

setting up your device”. 
2.3. Under “File Management” tab, click “Browse the contents of your 

device”; a new File Explorer window titled “Pocket_PC” will open. 
Note:  If this window does not automatically open, manually open a File 
Explorer window and navigate to “Pocket_PC” under “This PC” . 

2.4. Open the “ \ “ folder. 
2.5. Open the “Program Files“ folder. 
2.6. Open the “SurvCE” folder. 
2.7. Open the “Data” folder. 
2.8. Sort files by Name to find the files for your survey job and copy them 

to a new folder on your computer or flash drive. 
Note:  There will be up to five files for each job: CRD File, Setup Information, 
NOT File, RW5 File, and System File. 

2.9. Windows Mobile Device Center can now be closed and Carlson data 
collector disconnected from computer and powered down. 

3. Processing data using Carlson X-Port 

file:///D:/B.VanDam/Instruction_Manuals/www.accuratedata.com/wordpress/index.php/2017/08/02/
file:///D:/B.VanDam/Instruction_Manuals/www.carlsonsw.com/support/software-downloads/
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3.1. Open Carlson X-Port software. 
3.1.1. If Registration Wizard pops up, choose “Register Later” 

radio button under Registration Options tab and click Next. 
3.2. In Carlson X-Port window, click File > Open RW5 File. 

3.2.1. Navigate to location of saved survey files and open your .rw5 
file. 

3.2.2. A spreadsheet showing instrument starting location, 
backsight setup, and distances and angles to survey points 
will open in the top half of the Carlson X-Port window. 

3.3. If you entered a true azimuth for the backsight in the field (or 
otherwise do not care about azimuth): 
3.3.1. Click File > Open CRD File to open coordinate file. 
3.3.2. A list of survey points with Point #, Easting, Northing, 

Elevation, and Description should open in the bottom half of 
the Carlson X-Port window. 
3.3.2.1. If this occurs, skip to step 3.5. 

If these data do not appear, continue to step 3.4. 
If you entered a magnetic azimuth for the backsight in the field 
and need to adjust for magnetic declination: 
3.3.3. Find magnetic declination for survey area at 

ngdc.noaa.gov/geomag/calculators/magcalc.shtml 
Note:  Magnetic declinations for Maine coast range from -14.75 to -
16.5 (west declinations are negative). 

3.3.4. In the “SetAzi” cell in Carlson X-Port window, subtract 
magnetic declination from cell value.  
(e.g. 86.5(mag. az.) - [-15.3](declination) = 101.8(SetAzi)) 

Note:  This is the opposite direction from the action you would have 
taken in the field to convert magnetic azimuth to true azimuth. 

3.4. In Carlson X-Port window, click Process (Compute Pts) > No 
Adjust. 
3.4.1. When Process Options popup opens, ensure “Report 

SideShots” is checked and click OK. 
3.4.2. When Traverse Points popup opens, click OK. 
3.4.3. When Process No Adjust Results popup opens, close it. 

https://ngdc.noaa.gov/geomag/calculators/magcalc.shtml
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3.4.4. A list of survey points with Point #, Easting, Northing, 
Elevation, and Description will open in the bottom half of 
the Carlson X-Port window. 
For reasons unknown, X-Port will often place the backsight (Pt 2) 
directly north of the starting point during this processing step despite 
calculating correct coordinates for all other points [If you adjusted the 
SetAzi value during step 3.3, it will be directly to the magnetic north 
– note that in this case, the Easting for Pt 2 will not be identical to 
that of Pt 1, which may make it more difficult to spot]. If this occurs, 
the backsight coordinates can be corrected during step 3.7. 

3.5. In Carlson X-Port window, click Tools > Export Point Data > 
Text/ASCII File. 
3.5.1. When Export Point Data popup opens, change Coordinate 

Order check box to “Pt# East North Elev Desc” and click 
OK. 

3.5.2. Enter a save location and file name and click OK to save 
comma separated text file. 

3.6. Navigate to the text file in File Explorer and open it using Notepad or 
equivalent. 
3.6.1. Insert the following string above the first row: 

PtNo,Easting,Northing,Elevation,Description 
3.7. If you have no further edits to make to the file: 

3.7.1. Save and close text file. 
If you processed points (step 3.4) and the backsight is in the 
incorrect location: 
3.7.2. Return to Carlson X-Port window. 
3.7.3. If you entered a true azimuth for the backsight in the 

field: 
3.7.3.1. Set “SetAzi” cell to 0. 
If you entered a magnetic azimuth for the backsight in 
the field and need to adjust for magnetic declination: 
3.7.3.2. Set “SetAzi” cell to the additive inverse* of the 

magnetic declination. 
(*a.k.a the negative or opposite) (e.g. SetAzi = 15.3 if magnetic 
declination = [-15.3] ). 
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3.7.4. Repeat step 3.4. 
3.7.5. Copy the correct Easting and Northing for the backsight 

point (only) to update the appropriate line in the text file. 
3.7.6. Save and close text file. 
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Appendix A 
Parts of the total station unit (TSU) 

 
From Sokkia CX series Operator's Manual (see WPES Lab Resources Google 
Drive or us.sokkia.com/content/cx-user-manual for full document).   

https://us.sokkia.com/content/cx-user-manual
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Appendix B 
Prism height calibration with pole adapter 

 

Our original prism pole is meant to be paired with a prism that measures 14 cm 
tall from base to prism center.  However, our original prism only measures 10 
cm from base to center, resulting in a 4 cm discrepancy between actual target 
height and prism pole reading if the pole adapter is not adjusted. 

To calibrate, the threaded pole adapter bolt at the top of 
the telescoping prism pole must be unscrewed until 
actual target height matches the prism pole reading (in 
this case, a 4 cm extension).  When the pole adapter is at 
the correct length, the lower check nut should be screwed 
down to lock the adapter in place. 

 

Pole adapter bolt 
(At top of telescoping pole, 
not properly adjusted in 
this scenario) 

Actual target height 
(Measured to center of prism) 

e.g.  1.51 meters 

Prism pole reading 
(What the pole thinks the 
target height should be, if 
paired with a matching 
prism with specific arm 
lengths) 

e.g.  1.55 meters 

Check 
Nut 
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